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Introduction

What is PPS
The Softrol PulseNet Production System (PPS) is an integrated hardware and software system that collects, calculates, 
and reports productivity information necessary to effectively manage and control textile rental production operations 
and industrial laundries. The PPS system

•	 enables	data	acquisition	from	the	plant	operations	floor,
•	 tracks operator performance at each workstation,
•	 collects real time machine and labor load production information,
•	 automates the work measurement data processing tasks,
•	 produces productivity labor reports, 
•	 reduces labor, and 
•	 increases	profits.

Softrol developed the PPS system; therefore the system integrates many of Softrol’s existing technologies with 
SmartCard	identification	cards.	The	system	uses	networked	PPS	modules	located	at	workstations	throughout	the	

Distributed 
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PPS Monitor PC
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Figure 1. System Overview. Accessible over the corporate network, the system reports real-time production information gathered from modules 
located at the plants productivity centers. 
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plant. These modules communicate over a dedicated network sending real-time production information for reporting 
and	production	control	(see	Figure	1).	The	system	notifies	management	about	production	lags	and	maintenance	issues	
in real time allowing for quick resolution. 

Workers log into the workstation PPS module using their SmartCards. The system recognizes the worker and makes 
tasks available to them based on the cost center associated with the monitoring station. While the worker performs 
the task (manual and daywork tasks excluded), the system continually updates the worker about their performance 
and productivity based on their time and piece counts (see Figure 2).

PPS	collects	the	production	information	from	the	plant	floor	and	displays	it	on	the	message	centers	allowing	
management to respond quickly to production issues. Since the real-time data is being collected and managed at each 
individual PPS monitored station, the system operates continuously even in the event of a PC or network interruption. 
Management can always view detailed reports from any networked connected device with a web browser. 

Using this guide
Softrol	typically	installs	a	turn-key	system,	where	all	you	need	to	do	is	learn	how	to	make	modifications	and	use	
the reporting tools in PPS. Recently some plants have taken on the task of installing their own system. This guide is 
designed to aid both in the setup and maintenance of the PPS Monitor Software. 

Figure 2. Workers	at	a	roller	press.	The	workstation	is	set	up	for	either	five	individuals	to	work	side-by-side	logged	into	
their own PPS monitor (photo is of a workstation using classic monitors instead of touchscreen) or logged into a group 
task using the Team Station. This group is logged into the Team Station performing a three-person task.



3

PPS

Softrol Systems Inc. Softrol.com

PPS Login
Settings Help

Program Settings

Exit
Import/Export ...
Database Version ...

Figure 3. PPS Program Settings.

If Softrol technicians installed your system, this step is complete and you can skip it. If you need to update or set up the 
network	and	database	settings	for	the	first	time,	it	is	recommended	that	you	get	the	assistance	of	a	Softrol	PPS	support	
professional before proceeding. To access the network and database settings:

1. Locate and open the PPS Monitor software  on the PPS Workstation PC (If you need to setup the PPS 
Workstation see Appendix B).

2. Enter your User ID and Password (provided during system installation) then click OK.

3. Click Settings> Program Settings in the top menu to open the PPS Program Settings dialog (see Figure 3). 

4. Click the Properties tab.

5. Provide the location for the Reports login Web Page.

6. Provide a password in the Shutdown Password field	to	prevent	unauthorized	shutdown	of	the	monitor	
program.

7. Ignore Enable Cart Build options and Cart build Only Install unless your plant tracks cart check-in and checkout. 

8. Check the box for Auto Start Monitor Program at this Workstation if this is the main PPS workstation 
computer. In the event of a power failure or system reboot this will assure that the PPS Monitor program 
starts automatically when the system comes back up.

9. Check the Enable Output When in Maint Mode to turn on the indicator light when the system is in 
maintenance mode.

10. Check Use Bulk Fold single Scanner to use only the audit scanner for bulk fold.

Network and Database Settings
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11. Check Don’t Round Time Clock to prevent the system from rounding off the employee start and end times.

12. Click Apply (see Figure 4).

13. Select the Database Connection tab (see Figure 5).

14. Provide the database Server Address (most often 192.168.100.254), Database Name (PPS), and the Driver 
location (provided by your IT department).

15. Click Apply.

16. Click OK.

htttp://172.18.2.139/ppsreports/login.asphttp://172.18.2.139/ppsreports/login.asp

Include Manual Workstations
Include Clean Bag System Support
Use Fast Updates For PPS Devices
Enable Cart Build Options

Cart Build Only Install
Auto Start Monitor Program at this Workstation

Shutdown Password:

Apply OK Cancel

Reports Login Web Page:

Properties Database Connection

Enable Output when In Maint Mode

Include Clean Bag System Support

Use Bulk Fold Single Scanner

Enable Cart Build Options
Cart Build Only Install

Auto Start Monitor Program at this Workstation

Shutdown Password:

PPS Program Settings

Don’t Round TimeClock

Figure 4. PPS Program Settings: Properties dialog.

Properties Database Connection

Server Address:

Database Name:

Driver:

Apply OK Cancel

PPS Program Settings

192.168.100.254

PPS

PPS

Figure 5. PPS Program Settings: Database Connection tab.
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Using the Production Control Window

You use the Softrol-Production Control	window	to	define	the	company	information,	customers,	cost	centers,	
departments, employees, monitoring stations, and tasks (see Figure 6). You will use this portion of the program to set 
up your system and manage it. 

The frame on the left side of the window gives you the option to view your system based on department or items: 
•	 Department: PPS associates each cost center, piece of equipment, monitoring station, employee, and task 

with a department. Using the department view you can easily see these relationships by selecting and 
expanding the departments.

•	 Items: The item view separates the components into groupings. The term items, in the PPS system, refers 
to the individual components that make up a PPS System: departments, customers, cost centers, employees, 
monitoring stations, schedules, and tasks. Selecting an item grouping allows you to see all of the items for that 
type in the frame to the right. For our purposes we will use the Item List view.*

To begin: Click the Setup up button on the PPS Monitor Setup home screen (see Figure 7).

Figure 6. Softrol-Production Control Setup interface.

Setup

Figure 7. PPS Monitor Setup home screen.
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Set or Modify the Company Information

Each department belongs to a company and/or a division. You access and edit this information at the top of the 
department view. To set or modify the company information:

1. Click the top item in the list on the left to highlight it. This is the company information. 

2. Right-click the highlighted text and select Properties (see Figure 8).

3. Complete or change the company information and click OK (see Figure 9).

Figure 8. Softrol-Production Control Setup dialog: Set the Company Information

Company Maintenance

Company ID

Properties

Name:

Address 1:

Address 2:

Address 3:

City:

State:

Zip:

Apply OK Cancel

Figure 9. Company Information dialog.
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Managing Customers

Very few plants track productivity by customer. If your plant tracks by customer, you can manage them using the Setup 
dialog. Although you may not track productivity based on customer, each plant will have one customer, “Unassigned.” 

Add a New Customer
To add a new customer:

1. Expand the Item List.

2. Click the Customers folder to highlight it.

3. Right-click the highlighted Customers folder, and select New to open the Customer Maintenance dialog 
(see Figure 10).

4. Enter a unique numeric Customer ID.

5. Complete the Name and Display Order	fields	(see	Figure	12).

Modify a Customer

You can change the Short Name, Name, Display Order, and Activation for a customer. You can’t remove or delete a 
customer from the system, but you can deactivate them. Deactivating them prevents them from appearing in future 
reports and on PPS devices. Your system will always have one default customer, “Unassigned.” You cannot modify 
the unassigned customer.

1. Expand the Items List and click Customers.

2. Find the customer in the list on the right, and double-click.

3. Modify the information and click OK (see Figure 12).

Figure 10. Right-click Customers, and select New.
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 Managing Departments

Your	plant	is	divided	into	logical	departments	such	as	soil,	wash	aisle,	and	finishing.	You	can	add	or	edit	the	
departments using the Department dialog. Once created you cannot delete or deactivate a department. 

Add a New Department

1. From the Items List select Departments to highlight it.

2. Right-click and select New (See Figure 11). 

Properties

Short Name:

Name:

Display Order:

Customer Maintenance

Displayorder is the order
the customer will display on 
the PPS device. It must be
a vaule between 1 and 199.
Use 999 to exclude the 
Customer from the list.

Active

Customer ID

Apply OK Cancel

Figure 12. Customer Maintenance dialog.

Figure 11. Setup: New Department.
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3. Add a Short Name (25 character limit) and Description.

4. Click the button  to the right of the Supervisor	field	to	select	the	department	supervisor.	Note:	PPS	
does not currently support the supervisor functionality, you can leave this set to the default. 

5. Specify  the list order for this department by setting the Order Number.

6. Enter the Budget Code (not required).

7. Click OK.

Modify a Department

To change a department’s information:

1. Click the Setup button in PPS Monitor.

2. Expand the Item Lists.

3. Select the Departments folder.

4. Double-click the department you wish to edit in the frame on the right.

5. Make your changes using the Departments dialog (see Figure 13). 

6. Click OK.

Properties

Department ID:

Short Name:

Description:

Supervisor:

Order Number:

Budget Code:

Department

Apply OK Cancel

Figure 13. Department: New Department dialog.
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Managing Cost Centers

A cost center in PPS is each area of activity in a department. It may be one touchscreen monitor attached to a single-
lane	ironer,	or	it	may	be	the	five	touchscreens	attached	to	a	multi-lane	ironer.	Each	cost	center	is	staffed	by	employees	
with	very	specific	tasks	that	produce	output.	PPS	measures	the	employee	output	along	with	the	production	times	to	
create	the	output.	As	your	plant	changes,	you	may	find	the	need	to	add	or	modify	a	cost	center.	

Add a New Cost Center

1. From the Items List highlight Cost Centers by clicking.

2. Right-click the highlighted Cost Center list item and click New (See Figure 14). 

3. Click the button  to the right of Department to select a department for the cost center. For more 
information on Departments see Managing Departments on page 8.

4. Enter a Short Name and Description.

5. Add the Default Task by clicking the button 	to	the	right	of	the	field.	For	more	information	on	tasks	
see Managing Tasks on page 12.

6. Add the Schedule* by clicking the button 	to	the	right	of	the	field.	For	more	information	on	schedules	
see Manage Schedules on page 35.

7. Complete	the	remaining	fields	and	click	OK (see Figure 15).

*At this time the Schedule feature is not used in PPS you may leave this to the default.

Figure 14. Setup: New Cost Center.
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Modify a Cost Center

To change a Cost Center’s information:

1. Click the Setup button in PPS Monitor.

2. Expand Item Lists.

3. Click Cost Centers.

4. Double-click the cost center in the list to the right (see Figure 16).

5. Make your changes in the Cost Center dialog (see Figure 15).

6. Click OK.

Figure 15. Setup: New Cost Center dialog.

Figure 16. Setup: Modify a cost center.
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Managing Tasks

Each	cost	center	has	one	or	more	tasks.	A	task	is	the	specific	activity	you	will	monitor	and	measure	at	the	cost	center.	
Use the Tasks dialogs to create new and modify existing tasks.

Add a New Task

1. Open PPS Monitor, click the Setup button, expand the Items List, and highlight Tasks by clicking.

2. Right-click the highlighted Tasks folder and select New (see Figure 17) to open the Cost Center Tasks 
dialog (see Figure 18).

3. Enter a Task ID, or click the Auto Num checkbox (recommended) for a system generated ID.

4. Enter a Short Name and Description.

5. Add the Cost Center Id by clicking the button 	to	the	right	of	the	field.	For	more	information	on	Cost	
Centers see page 10.

6. Add the Item Code by clicking the button 	to	the	right	of	the	field.	For	more	information	see	
Production Items on page 14.

7. Set the Company Task Code if the company uses a different code for the task than used here. 

8. Add the Collection Method by clicking the button 	to	the	right	of	the	field.	For	more	information	on	
collection methods see page 17.

9. Set the Apply Work To Cost Center	field	to	a	different	cost	center	ID	if	employees	can	log	into	daywork	
tasks for other cost centers from the same PPS work center monitor. Select the cost center for the task by 
clicking the button  to the right of the Apply Work To Cost Center	field.	

10. Set the task parameters. For more information on task parameters see page 19.

11. Click OK.

Figure 17. Setup: New Task.
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Modify a Task

To change a Cost Center Task’s information:

1. Click the Setup button in PPS Monitor.

2. Expand Item Lists.

3. Click Tasks.

4. Double-click the task in the list to the right.

5. Make your changes in the Cost Center Tasks dialog.

6. Click OK.

Properties

Task ID:
Short Name:
Description:

Company Task Code:

Collection Method:

Apply Work to Cost
Center:

Cost Center Task

Auto Num.

Prod Standard:

Apply OK Cancel

Cost Center ID:
Item Code:

>>

>>

>>

>>

>>

Number of Operators
/hour Production Pieces per Machine Count:

Rewash Percent:
Discard Percent:

%
%

Repair Percent: %

Missed Pieces starts Machine Off time to Increment. Must be greater
then 3. A zero will disable this feature

Enable Auto
Machine Off

Prod. Measure: Unit Weight: LBS/Piece

Figure 18. Setup: New Cost Center Task dialog.
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Production Items

Some tasks result in production items or a group of production items. Typical production items include: yellow 
napkins,	white	napkins,	black	napkins,	brown	mats,	or	white	fitted	sheets.	These	items	may	then	belong	to	item	
groups: napkins, mats, or sheets. While setting up your tasks you can also create and modify items and item groups 
(PPS Reports doesn’t currently utilize item groups).

To access the Production Items dialog:

1. Open PPS Monitor, click the Setup button, expand Item List, and select Tasks.

2. Double-click a task in the right pane, or right-click Tasks and select New to open the Cost Center Tasks 
dialog.

3. Click the button   to the right of the Item Code	field.

Add New Items

To create new items:

1. Click New from the Production Items dialog (see Figure 20).

2. Complete	the	fields	giving	the	item	a	unique	Item Code.

3. Click Save.

Item Code:

Figure 19. Cost	Center	Task:	Item	Code	field.
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Delete Items

To delete items:

1. Select the item in the Production Items dialog (see Production Items on page 14).

2. Click the Delete button.

3. Click OK	in	the	confirmation	dialog.

Modify Items

To modify an item:

1. Click to select an item in the Production Items dialog (see Production Items on page 14).

2. Modify	the	description	fields	(you	cannot	change	the	Item Code).

3. Click Save.

Figure 20. Production Items: New item.

Tablecloths
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Item Groups

Although PPS does not currently use the item group designation in its reports, you can set them up in anticipation 
of	a	future	update	that	will	allow	you	to	filter	your	report	results	based	on	item	groups.	You	can	add	your	produc-
tion items to item groups: 

1. Expand Item List, select Tasks, double-click a task in the right pane, or right-click Tasks and select New.

2. Click the button   to the right of the Item Code field	on	the	Production Items dialog.

3. Select the item that you would like to assign a group in the Available Items list.

4. Click the button   to the right of Group in the Item Group section to the right.

5. Select a group in the Available Items list.

6. Click Select.

7. Click Save on the Production Items dialog.

Figure 21. Cost	Center	Task:	Item	Group	field.

DescriptionGroup code

Available Items

Select

tablePK Table Packs

Select New Save Exit

Production Item Groups

Group code

Description

Figure 22. Cost Center Task: Item Group dialog.
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Create a New Item Group

If you don’t see the group you need in the item group selection dialog you can add a new group from the Produc-
tions Items dialog:

1. Select an item in the Available Items list.

2. Click the button   to the right of Group in the Item Group section to the right.

3. Click the New button on the Select dialog.

4. Enter a unique Group Code and Description.

5. Click Save (see Figure 22. Cost Center Task: Item Group dialog. on page 16).

Modify an Item Group

You can only modify the item group’s description. To modify an item group’s description navigate to the Produc-
tions Items dialog:

1. Select an item in the Available Items list.

2. Click the button   to the right of Group in the Item Group section to the right.

3. Change the item Description.

4. Click Save. 

Setting Task Collection Method

When	creating	tasks	you	will	need	to	define	how	the	system	gets	the	production	information	for	the	task.	You	will	
select the method from the Cost Center Tasks dialog:

1. Click the Setup button in PPS Monitor, expand Item Lists, and click Tasks.

2. Create a new task by right-clicking and selecting New, or double-click an existing task to modify an 
existing task (for more information see Add a New Task on page 12).

3. Click the button  to the right of the Collection Method field	(see	Figure	23).	
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4. Click your collection method in the Select dialog window:

•	 Automatic Collection: the system keeps track of the item counts by interfacing with the 
equipment’s counters.

•	 Manual Collection: the worker provides the task completion counts when logging off of the task.

•	 Day Work Task: the task is measured in hours worked. 

•	 Time Card:	The	task	functions	as	a	time	clock	to	log	employee’s	start	and	finish	work	times.

5. Click Select (see Figure 24).

Short Name:

Descriptoion:

Company Task Code:

Collection Method:

Apply Work to Cost
Center

>>

Figure 23. Setup: Cost Center Task dialog Collection Method setup.

Figure 24. Collection Methods Select dialog.
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Task Parameters

Depending on your Collection Method selection, you have different options in the measurement parameters sec-
tion of the Cost Center Task dialog. If you selected Day Work Task see Daywork Tasks Collection Method Measure-
ment Parameters on page 20. If you selected any of the other collection methods you have several options for 
your measurement parameter settings.

•	 Production Standard: the number of times the employee should complete the task per hour.

•	 Number of Operators: the number of employees assigned to a task.

•	 Production Pieces per Machine count: The number of completed items for each cycle of the counter.

•	 Rewash Percent: the normal percentage of items needing rewashed.

•	 Discard Percent: the normal percentage of items thrown out.

•	 Enable Auto Machine Off: this automatically logs an employee off a task after the designated elapsed time 
without activity. To enable this behavior, check the box and set the number of missed tasks to three or more.

•	 Unit Weight:	This	is	the	weight	of	a	finished	product.	Adding	a	weight	into	this	field	designates	that	this	is	
a	finished	product.	The	weight	should	reflect	the	weight	of	the	finished	item.	This	may	be	a	single	item	or	a	
bundle of items. 

•	 Production Measure: click the button 	to	the	right	of	the	field	to	select	the	unit	of	measurement	for	the	
task: pieces, pounds, time, or bundles.

Properties

Task ID:
Short Name:
Description:

Company Task Code:

Collection Method:

Apply Work to Cost
Center:

Cost Center Task

Auto Num.

Prod Standard:

Apply OK Cancel

Cost Center ID:
Item Code:

>>

>>

>>

>>

>>

Number of Operators
/hour Production Pieces per Machine Count:

Rewash Percent:
Discard Percent:

%
%

Repair Percent: %

Missed Pieces starts Machine Off time to Increment. Must be greater
then 3. A zero will disable this feature

Enable Auto
Machine Off

Prod. Measure: Unit Weight: LBS/Piece

Properties

Task ID:
Short Name:
Description:

Company Task Code:

Collection Method:

Apply Work to Cost
Center:

Cost Center Task

Auto Num.

Prod Standard:

Apply OK Cancel

Cost Center ID:
Item Code:

>>

>>

>>

>>

>>

Number of Operators
/hour Production Pieces per Machine Count:

Rewash Percent:
Discard Percent:

%
%

Repair Percent: %

Missed Pieces starts Machine Off time to Increment. Must be greater
then 3. A zero will disable this feature

Enable Auto
Machine Off

Prod. Measure: Unit Weight: LBS/Piece

Figure 25. Cost Center Task measurement parameters options.
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Daywork Tasks Collection Method Measurement Parameters 

When you select the Collection Method	“Day	Work	Task,”	you	have	an	extra	field	in	the	properties	tab	(Budgeted	
Hours), and only one option (Include in Earned Hours) in the Measurement Parameters section (see Figure 26).

•	 Budgeted Hours: this is the amount of time allowed for this task in hours.

•	 Include in Earned Hours: Check this box to include the time spent on this task in the employees earned 
hours worked (for more information about earned hours see Key Terms on page 71).

Budgeted Hours:

Include in Earned Hours

Day Work Task

Cost Center ID:

Item Code:

Apply

Cost Center Task

Properties

OK Cancel

Task ID:

Short Name:

Descrption:

Apply Work to Cost
Center:

Company Task Code:

Collection Method:

Figure 26. Cost Center Task measurement parameters options for Day Work Task collection method.



21

PPS

Softrol Systems Inc. Softrol.com

Managing Employees

As your staff changes you will need to add new employees, modify information, and deactivate employees that leave. 

Add a New Employee

1. From the Items List highlight Employees by clicking.

2. Right-click and select New (See Figure 27) to open the Employee Details dialog. 

3. Enter a unique numeric Employee ID. The system automatically copies the employee ID to the Badge 
Number Field (see Figure 28).

4. Modify the Badge Number if necessary. 

5. Enter the First and Last Name.

Figure 27. Setup: New Employee.

Employee Details

(2) Doe, Jane

Properties Employment

Employee Id:

First Name:

Title:

Employee Type:

Department:

Default Cost Center:

Default Language:

Badge Number:

Last Name:

Shift:

Paycode:

Dept Prefix:

Make SmartCard Apply OK Cancel

Jane Doe

Employee Details

(2) Doe, Jane

Properties Employment

Employee Id:

First Name:

Title:

Badge Number:

Last Name:Jane Doe

Properties Employment

Employee Id:

First Name:

Title:

Employee Type:

Department:

Default Cost Center:

Default Language:

Badge Number:

Last Name:

Shift:

Paycode:

Dept Prefix:

Make SmartCard Apply OK Cancel

Jane Doe

Figure 28. Employee Details Dialog: Employee Names and IDs.
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6. Click the buttons  next to the remaining	fields	to	set	their	values	(see	Figure	29). 
For more information on:
•	 Titles see Manage Employee Titles on page 24.
•	 Employee Type see Manage Employee Types on page 25.
•	 Department see Managing Departments on page 8.
•	 Default Cost Center see Managing Cost Centers on page 10;
•	 Shifts see Manage Employee Shifts on page 29.

7. Click the Employment	tab.	Complete	the	fields	as	required	by	your	plant	(all	optional)	For	more	information	
on Production Levels see page 23.

8. Press Apply to add the new employee to the database.

9. Click OK to exit the dialog and save any unsaved information.

Employee Details

(2) Doe, Jane

Properties Employment

Employee Id:

First Name:

Title:

Employee Type:

Department:

Default Cost Center:

Default Language:

Badge Number:

Last Name:

Shift:

Paycode:

Dept Prefix:

Make SmartCard Apply OK Cancel

Jane Doe

Employee Details

(2) Doe, Jane

Properties Employment

Employee Id:

First Name:

Title:

Employee Type:

Department:

Default Cost Center:

Default Language:

Badge Number:

Last Name:

Shift:

Paycode:

Dept Prefix:

Make SmartCard Apply OK Cancel

Jane Doe

(2) Doe, Jane

Properties Employment

Employee Id:

First Name:

Title:

Employee Type:

Department:

Default Cost Center:

Default Language:

Badge Number:

Last Name:

Shift:

Paycode:

Dept Prefix:

Make SmartCard Apply OK Cancel

Jane Doe

Figure 29. Employee Details Dialog:.
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Figure 30. Employee Details Dialog: Employment tab:.
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Set Employee Production Levels*

You expect different levels of performance from employees based on their length of employment and skill levels. 
To ensure that you evaluate the employee’s performance accurately you need to set their production level. To set 
an employee’s production level:

1. Click the button  to the right of the Production Level field	located	on	the	Properties tab of the 
Employee Details dialog. 

2. Select the employee’s production level from the Available Items list:
•	 Training;
•	 Standard; and 
•	 Intermediate.

3. Click Select.

* Employee Production Levels are not currently supported in PPS. You may choose to set them for your own re-
cords.

Figure 31. Employee Details Dialog: Employment tab:.
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Figure 32. Select Title Dialog.

Manage Employee Titles

PPS doesn’t currently use the titles data. You may wish to include them for your own records. You can add new 
employee titles or assign a title to an employee using the Employee Title Select dialog box.

1. From the Items List highlight Employees by clicking.

2. Right-click and select New (see Figure 33) or double-click an existing employee if you would like to 
change the employee’s title. This opens the Employee Details dialog (see Figure 29 on page 22).

3. Click the button   to the right of the Title field	on	the	Employee Details dialog. This opens the Title 
Selection dialog window (see Figure 32).

Assign a Title
To assign a title:

1. Select a title in the Available Items list.

2. Press Select.

Figure 33. Setup: New Employee.
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Add a New Title
You can create a new title using the Title Selection dialog (see Figure 32).

1. Click New.

2. Give the new title a unique Title Code.

3. Complete the Description	field.

4. Click Save.

5. Click Exit to leave the dialog without assigning the title.

If you would like to assign the new title to the current or new employee:
1.  Select the new title in the Available Items list. 

2. Click Select. 

Manage Employee Types

PPS doesn’t currently use the Types data, but you may want to set them for your own records. An employee type 
indicates their function such as maintenance, driver, production, and clerical. You can add or assign an employee 
type using the Employee Type Select dialog box.

1. Highlight Employees in the Items List by clicking.

2. Right-click and select New (see Figure 34), or double-click an existing employee to change the employee’s 
type. This opens the Employee Details dialog (see Figure 29 on page 22).

3. Click the button  to the right of the Type field	on	the	Employee Details dialog. This opens the Type 
Selection dialog window (see Figure 35).

Figure 34. Setup: New Employee.
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Assign an Employee Type

To assign an employee type:

1. Click to highlight a type in the Available Items list.

2. Press Select (see Figure 35).

Add a New Employee Type
You can also create a new employee type using the Select dialog box (Figure 35).

1. Click New.

2. Give the new title a unique Type Code.

3. Complete the Description	field.

4. Click Save.

5. Click Exit to leave the dialog without assigning the type.

If you would like to assign the new type to the current or new employee:
1. Click the type in the Available Items list. 

2. Click Select.

Figure 35. Select Type Dialog.



27

PPS

Softrol Systems Inc. Softrol.com

Update Employee Employment Information

Within PPS you can include the employees personal information. This optional information is located on the Em-
ployment tab of the Employee Detail dialog window.

1. Open PPS Monitor, click the Setup button, expand the Item Lists, and click Employees. 

2. Double-click an employee record in the list on the right (see Figure 36) to open the Employee Details 
dialog (see Figure 37).

3. Click the Employment tab.

4. Enter or change any data and click Apply then OK.

Terminate an Employee

Although you can’t delete an employee from the system, you can deactivate them by setting a termination date.

1. Click to check the checkbox inside the Termination Date	field.	The	system	defaults	to	the	current	date.

2. Click the down arrow to open the calendar tool to set a different date if needed (see Figure 37).

Figure 36. Setup: Select an employee.
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Figure 37. Employee Details Dialog: Employment tab terminate an employee.
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Reinstate a Terminated Employee

If you bring an employee back after termination you can reactivate their old account by removing the check from 
the Termination Date	field.	

1.  Open PPS Monitor, click the Setup button, expand the Item Lists, and click Employees. 

2. Click View from the main menu and select All Items (see Figure 38).

3. Locate the employee you wish to reinstate in the list on the right and double-click their name.

4. Uncheck the Termination Date	field.

5. Reset the View menu back to Active Items.

Figure 38. Softrol-Production Control View menu options.
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Manage Employee Shifts

PPS	Reporting	uses	shifts	to	filter	your	reporting	data.	It	is	very	important	that	an	employee’s	shift	is	reflected	
properly in PPS, for their production is reported and credited to their shift regardless of when they complete it. 
You can assign an employee’s shift from the Employee Type Select dialog box.

1. Open PPS Monitor, click the Setup button, expand the Item Lists, and click Employees. 

2. Right-click and select New (see Figure 39) or double-click an existing employee if you would like to 
change the employee’s shift. This opens the Employee Details dialog.

3. Click the button  to the right of the Shift field	on	the	Employee Details dialog. This opens the Shift 
Selection dialog window (see Figure 40).

Assign a Shift
To assign a shift:

1. Select a shift in the Available Items list.

2. Press Select.

Figure 39. Setup: New Employee.

Figure 40. Select Shift Dialog.
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Delete a Shift
Deleting shifts can have adverse affects on your system. It is not recommended that you delete shifts. You can 
rename them to indicate that your plant doesn’t use them without impacting your system. If you decide to delete 
the shifts: 

1. Open PPS Monitor, click Setup, expand the Item List, and highlight Employees.

2. Right-click Employees, and select New.

3. Click the button  to the right of the Shift text box to open the Select dialog. (see Figure 41) 

4. Click to highlight the shift you wish to delete in the Select Shift dialog. 

5. Click Delete (see Figure 42).

6. Select Yes	in	the	confirmation	dialog.
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Figure 41. Shift Text field and selection button.

Figure 42. Select Shift Dialog.
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Modify a Shift Name
You can modify the shift names without fear of causing problems. If your plant uses a different naming convention 
for shifts you can change them in the Select Shift dialog.:

1. Open PPS Monitor, click Setup, expand the Item List, and highlight Employees.

2. Right-click Employees, and select New.

3. Click the button  to the right of the Shift text box to open the Select dialog (see Figure 41). 

4. Click to highlight the shift you wish to modify in the Select Shift dialog. 

5. Change the Description (see Figure 42).

6. Click Save.

7. Click Exit to close the dialog.
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Manage Employee Language Preference

If an employee needs system prompts in Spanish, you can change the default language preference for the employee.

1. From the Items List select Employees.

2. Right-click and select New (see Figure 43) or double-click an existing employee if you would like to 
change an existing employee’s language preference. This opens the Employee Details dialog.

3. Click the button  to the right of the Default Language field	on	the	Employee Details dialog. This opens 
the Language IDs Selection dialog window (see Figure 44).

4. Select a language in the Available Items list.

5. Press Select.

6. Save your changes by clicking OK.

Figure 43. Setup: New Employee.

Figure 44. Select Default Language Dialog.
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Make SmartCards

Each employee needs their own unique SmartCard. To make a new or replacement SmartCard:

1. Open PPS Monitor, expand the Items List and right-click the employee in the list to the right.

2. Select the Make Employee SmartCard option in the menu to access the Create SmartCard dialog (see Figure 45). 

3. Click the Settings tab.

4. Verify your settings:
•	 Type of Writer: OmniKey
•	 Communications Port: USB
•	 Baud Rate: 9600 (the system does not use this setting for USB card writers; value is unimportant). 
•	 RFID: checked.

5. Plug the card reader/writer into an available USB port on the Workstation PC.

Softrol-Production Control

New ...

Copy ...

Display for Print ...
Make Employee SmartCard...

Properties

Figure 45. Setup Employees: Make a SofCard for an existing employee.

(2) Doe, Jane

Properties Settings Print

RFID

Type of Writer

Communications Port

Baud Rate:

OmniKey

USB

9600

Test

Apply Cancel

Create SmartCard

Figure 46. Create SmartCard Dialog: Settings.
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6. Insert the card into the USB card reader (see Figure 47). Keep the gold square facing up. You can see the readers 
logo and the gold square at the same time. 

7. Click Write on the Create SofCard dialog Properties tab. 

8. Verify that you have successfully written the card by clicking the Read button.

9. If your plant uses a card printer you can customize the look of each card. See the documentation accompanying 
your printer for complete instructions.

10. Close the dialog window.

11. You can also make a generic card. Select Tools > Generic Card on the PPS Monitor Setup window. Follow the 
same procedures for the generic as you do for the employee cards.

Figure 47. Insert the SmartCard into the card reader/writer. 
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Manage Schedules

PPS doesn’t currently use the schedule designation in its reporting, instead shift information is managed through the 
PPS Report’s Administration Options: Production Shifts page (See Production Shift Set Up on page 46). You can just 
leave the default as is, or you may want to set them up in anticipation of future functionality. 

Your	plant	may	maintain	several	different	schedules.	You	can	find	the	schedules	by	opening	PPS Monitor, expanding 
Item List, and clicking on Schedules (see Figure 48). 

Add a New Schedule

To create a new schedule:

1. Open PPS Monitor, click Setup, expand Item List, highlight Schedules by clicking it.

Figure 48. Setup Schedules. Right-click to add a new schedule.

Figure 49. Set Schedules dialog box.
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2. Right-click the highlighted Schedules item and select New to open the Set Schedules dialog box (see 
Figure 49).

3. Give the schedule a name.

4. Set the start times for each shift for each day.

5. Click Save.

6. Click New to add another schedule, or Exit to close the dialog.

Modify or Delete a Schedule

You can delete or modify a schedule by opening PPS Monitor, click Setup, expand Item List, and select Schedules.

1. Right-click an element on the schedule you want to modify or delete.

2. Select Properties (see Figure 50).

3. Make changes followed by Save to modify a schedule.

4. Click Delete to permanently remove a schedule.

Figure 50. Modify or delete a schedule by right-clicking the schedule (or one of its elements) and selecting Properties.
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Delete New Save Exit

Figure 51. Set Schedules dialog box.
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Manage Monitoring Stations

Each PPS setup is slightly different, and your plant may only have a couple monitoring stations or several dozen. 
Softrol	installers	may	have	set	up	your	PPS	monitoring	stations	initially.	They	configured	the	monitoring	stations	
specifically	for	your	plant.	If	you	order	a	replacement	monitoring	station	(touchscreen)	it	will	need	configured	for	
your	system.	The	replacement	monitor	includes	configuration	instructions,	or	you	can	download	the	instructions	
directly from the Softrol Support website (Support.Softrol.com). This section focuses strictly on adding and managing 
monitoring stations within the PPS Monitor workstation PC. This section does not cover the details for hardware 
installation

Add a New Device to PPS Monitor

Once a PPS device is installed you need to add it to the PPS Monitor program. 

Get the Monitoring Station IP Address

Your monitoring stations communicate with the PPS Workstation PC through the local network. The PPS Worksta-
tion needs to know the network address for each PPS device. The PPS Monitor Stations use a static IP address. To 
add a PPS device to the network you need to know the devices IP address and the address for its ARCNET net-
work. 

When	powered	on,	you	can	find	the	IP	address	for	each	monitor	in	the	lower	left	hand	corner	of	the	screen	(see	
Figure 52). Record this number for later use.

Add a New Monitoring Station

To add a new monitoring station:

1. Open PPS Monitor on the PPS Workstation PC .

2. Click the Setup button.

3. Enter your user password.

4. Expand the Items list and click Monitoring Stations to select it.

Update Database

IP: 192.168.1.91

Figure 52. The IP address is located in the lower left corner of the monitor screen.
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5. Right-click the selected Monitoring Stations in the Items List (see Figure 53). 

6. Click New to open a blank PPS Device dialog (see Figure 54).

Properties Tab Set Up

On the Properties	tab	you	define	the	basics	for	a	new	monitoring	station.		

1. Provide a descriptive name in the Name 
field.

2. Click to check the Touchscreen checkbox 
(for most new installs).

3. Make sure Active is checked.

4. Enter the IP Address for the device.

5. Enter a Network Address (touchscreen 
only).

Figure 53. Select and then right-click Monitoring Stations and select New.

Current Status

Name:

Properties    Display Status Setups Tasks Update Device

Active Touch Screen

Device Code

Description

IP Address

Network

Device Type

Counting Method:

Cost Center

PPS Device

Figure 54. PPS Device dialog: Properties tab.
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6. Click the button  to the right of Device Type to access the Device Type selection dialog (see Figure 55). 
For more information on the available device types see PPS Device Types on page 53.

7. Click to select a device type in the Available Items list.

8. Click Select to return to the PPS Device dialog.

9. Repeat Steps six through eight to set the Counting Method and the Cost Center. For more information about 
Counting Methods see Setting Task Collection Method on page 17.

10. Click Apply to validate your settings and to create the device in the system. 

Adjust the Setups Tab 

Once you have created a new device you can set further details about the device. The Setups tab configures	the	
device behaviors (see Figure 56). 

1. Check the Mend and/or Stain checkboxes if you would like to include the items sent for mending or stain 
removal in the employee’s production counts.

2. Check Prompt for customer during task selection if your plant tracks product by customer. 

3. Check Allow Machine Off time to increment if no activity for task to log the time between the last task 
count and the auto task shutoff as non-operation time for the machine.

4. Check Record Machine counts when No Badge Inserted if you would like to record production counts 
even if the employee didn’t insert their card.

5.  Set the number of minutes the device should sit idle before automatically ending the task.

6. Set the number of seconds before PPS errors when the number of operators does not match the task 
requirements. 

7. Set the Minimum Input Count Pulse Width when you want to ensure that the main counter counts 
only whole items. If pressing aprons for example, the system will sense a long pulse for the body of the 

Select

Available Items

Device Type Description
9
8
7
6
5
4
3
2
1

Team Device with Auto Task
Cart Build Device
Department Device
Bulk Fold
Scale Station
Cost Center Station
Production Pacing Device
Team Pacing Device
Time Clock

PPS Device Types

Device Type

Description

4

Cost Center Station

Select
Delete Save Exit

Figure 55. PPS Device Type Selection dialog.
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apron	and	possibly	two	or	more	short	pulses	caused	by	apron	strings	or	straps.	By	giving	this	field	a	value	
greater than zero the system ignores the shorter bursts. 

8. Set the 2nd Minimum Input Count Pulse Width to prevent inaccurate counts in your stain and mend 
counts due to multiple pulses caused by apron strings and straps.

9. Set	the	hour	and	minute	fields	of	the	Auto Reset Total Counts option to clear the touchscreen of an 
employee’s production counts after a given period of time. This prevents the following error: if no other 
worker logs into a station between the time that the previous worker logs out and that worker logs 
back into the same station (even several hours later or the next day) the station mistakenly credits the 
operator with their old counts. Giving the task an expiration prevents the error.

10. Ignore Paycode unless using the payroll features of PPS (rare).

11. Use the Hot Keys to set task shortcuts on the device. These tasks appear when a user taps the Favorites 
icon on the PPS touchscreen device.

12. Select a Barcode Scanner Setting option if the station uses a scanner. Your options include:
•	 No Scanner,
•	 Scan is a Mend,
•	 Scan is a Stain,
•	 Scan is a Piece Count, or
•	 Define	your	own.

13. Click Apply.

Current Status
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Properties    Display Status Setups Tasks Update Device

Increment Total Production Count on:

PPS Device
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Prompt for customer during task selection
Allow Machine O� time to incremnt if no activity for task
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Automatically End Current Task if no activity after

If incorrect number of operaors, Disable Machine after

Minimum Input Count Pule Width

2nd Minimum Input Count Pulse Width

Auto Reset Total Counts after hours and minutes

minutes

seconds

seconds

seconds

Paycode

Hot Key 1: Assigned Task

Hot Key 2: Assigned Task

Hot Key 3: Assigned Task

Hot Key 4: Assigned Task

Hot Key 5: Assigned Task

Barcode Scanner Setting

Apply OK Cancel

Figure 56. PPS Device dialog: Setups tab.
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Bulk Fold Setups Tab

If you designate the monitoring station as a bulk fold station, you will have different setup options (see Figure 
57).	The	Setups	tab	has	fewer	fields.	You	can	get	explanations	for	the	first	four	options	in	Adjust	the	Setups	Tab	on	
page 39. The bulk fold method has two additional options:

Task Credited for Audit Count

Click the Select 	button	to	select	a	pre-configured	task	for	the	bulk	fold	auditor.	This	task	is	frequently	named,	
“Audit” and it counts each barcode scan against a standard count. 

Select Card Slot for Audit Count Credit

The drop-down allows you to assign the auditor to another slot on the Team Station. The default is slot eight un-
less you select a different option.

Operating Correctly

Task Credited for Audit
Count

Select Card Slot for Audit
Count Credit

Figure 57. PPS Device dialog: Setups tab for a bulk fold station.
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Tasks Tab: Assigning tasks to a Device

Predefined	earlier	in	the	process	(see	Managing	Cost	Centers	on	page	10),	each	task	is	specific	to	a	cost	center.	
The Tasks tab of the PPS Device dialog contains a list of the available tasks for the device in that cost center. By 
default the system makes all of the cost center’s tasks available on the monitoring station. You can limit the tasks 
available	at	a	specific	workstation	by:

1. Check the Selected Items Only checkbox. 

2. Place a check in the boxes of the tasks you would like to make available on the device.

3. Click the Apply button.

Status Tab: Adjusting the Poll and Read Intervals

The Status tab provides information about the devices communication history and the PPS version information. 
You can set how often PPS asks for status data (operator, task, status) using the Poll Interval. And you can set how 
often the application attempts to gather production data using the Read Interval setting. Using the PPS Monitor 
Status Screen’s Settings tab you can set the default values for every device, but this allows you to change the inter-
vals for this device only.

Current Status

Name:

Properties    Display Status Setups Tasks Update Device

Available Tasks for Device

PPS Device

Name

Selected Items Only

Apply OK Cancel

Select All

Task ID Cost Center Prod. Std. Pro

Figure 58. PPS Device dialog: Tasks tab.
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Other Settings and System Tools

You	have	almost	completed	your	PPS	configuration.	The	developers	moved	some	configuration	and	maintenance	tasks	
off the application and placed them within your reports options. Moving these activities here allows you to access 
these	settings	and	tasks	from	any	computer	that	can	access	reports.	To	access	these	configuration	settings:

1. Open reports by clicking the Reports button (see Figure 59) in PPS Monitor (or use the URL provided to you).

2. Scroll to the bottom of the Reports Home page

3. Locate the heading for Administrator Options (see Figure 60).

Reports Reports

Figure 59. PPS Monitor Setup home screen: Reports Button.

Administration Options

User Administration

Budgeted, Non Productive Time Setup

Message Center Setup

Text Message Setup

Work History Adjustments

Production Shifts

Figure 60. Administration Options.
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Budgeted, Non-productive Time Set Up
During the course of the day employees have time that is not accounted for by a productivity task. This time 
may include, paid breaks, time to transition between the time clock and the cost center, or bathroom breaks. So 
that this normal downtime doesn’t interfere with the employees’ efficiency percentage, you can allow for this 
downtime. The following example is for demonstration purposes. You will enter values based on your local labor 
codes and plant policies. When entering this screen for the first time it will appear with “No Settings Entered,” as 
in Figure 61.

From the Administration Options section of the Reports Home page:

1. Click the menu option, Budgeted, Non-productive Time Set Up.

2. Enter	the	first	block	of	time	by	entering	the	To time. The From time is already set at 0.0 hours. 

3. Enter	the	number	of	minutes	of	idle	time	you	will	allow	during	this	first	block	of	time.

4. Click Add (See Figure 62).

5. Continue adding blocks of time until you have covered all the possible scenarios.

Figure 61. Budget, Non-Productive Time Set Up: initial screen.

Figure 62. Budget, Non-Productive Time Set Up: Set the first block of allowed idle time.
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6. Remove blocks by clicking the Remove Record hyper link.

7. Apply the changes to existing clock records by adjusting the date in the Update Time Clock Records box and 
clicking Submit. 

8. Exit the page. The new settings take effect for new employee clock records without any further action 
required.

Figure 63. Budget, Non-Productive Time Set Up: Multiple records.
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Production Shift Set Up
PPS uses the production shifts to set time parameters on many of the reports. Your plant needs to have three shifts set 
up. Even if your plant doesn’t have three shifts, the system requires that you include them. When setting up your shifts:

•	 Set times for all three shifts covering a full 24 hour period.
•	 Use the end time of each shift as the start time for the next shift.
•	 Do not leave any gaps between shifts.
•	 Do not overlap shifts.
•	 Shifts can have different lengths.
•	 Use the format HH:MM AM or PM when entering time.

To set up your shifts:

1. Open PPS Reports> Administrator Options> Production Shifts.

2. Adjust your shift start and stop times.

3. Click the Update button.

Back to Home Page

Production Shift Admin

Use this page to alter the production shift times

Shift Code   Description     Start Time      End Time
1 st
2 nd
3 rd

First Shift
Second Shift
Third Shift 

NOTE:
Times should be entered in as HH:MM AMPM format.

1. Between the three shifts the entire day must be covered with no gaps.
2. The end of one shift should be the same as the start of the next.

3. Shifts cannot overlap.

Update

5:00 AM
6:00 PM
2:00 AM

6:00 PM
2:00 AM
5:00 AM

Figure 64. Production Shift Admin.
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PPS Message Centers

Your plant will have one or more message centers. These message centers consist of a large screen monitor and a small 
computer (mounted behind the monitor). The message centers receive real-time information from the PPS Monitor 
application running on the PPS workstation PC. If the PPS Monitor application is not running, the message centers 
cannot display current information.

The message centers display the information about each PPS workstation monitor in the production environment 
(see Figure 65). This information is displayed in table format with each row representing a workstation monitor. The 
message center displays eight workstations at a time and automatically cycles through the remaining stations eight at 
a time.

At	the	top	of	the	screen	you	can	find	the	message	center	ID	and	the	date	and	time	of	the	last	data	refresh.	The	
remainder of the screen contains the productivity information in table format for each workstation. Each row contains 
the real-time status for each workstation. From left to right the data includes:

•	 the	logged	in	employee’s	name	(initials	only,	fist	name	and	last	initial,	or	first	initial	and	last	name),
•	 current task and workstation,
•	 current	task	efficiency,
•	 current	task	efficiency	meter,	and
•	 current	daily	efficiency	(based	on	all	of	the	employee’s	activity	for	the	day	without	regard	to	task	or	workstation).

The system displays green for employees working at normal production speeds or higher, gold for employees working 
slightly under standard production speeds, and red for under performing employees.

Figure 65. Message Center Screen.
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Managing Message Centers
The PPS Message Centers have evolved to become the standardized version discussed previously. Of course you can 
purchase customizations for your message centers by contacting your regional Softrol Sales Representative. The 
following instructions allow you manage message centers based on the new standardized version.

You will manage your message centers from the Administration Options: Message Center Setup on the PPS Reports 
Home page (see Other Settings and System Tools on page 43 for information about accessing the Message Center 
Setup	page).	When	accessing	these	pages	you	will	find	many	fields	that	go	unexplained	in	this	instruction	set.	The	
fields	support	older	message	centers	and	customizations.	You	will	only	need	to	complete	the	fields	outlined	here.

Add a New Message Center

To add a new message center navigate to PPS Reports using your browser or using the Reports button in the PPS 
Monitor Settings application.

1. Click the Message Center Setup link under Administration Options to open the Message Center Admin page. 

2.  Click Add a new record (see Figure 66).

3. Give the message center a unique numerical ID.

4. Ignore	all	the	other	fields	on	this	page	and	press	the	Insert Message Center at the bottom of the form ( see 
Figure 67).

Add a new record.
View

Message Center Admin

Add a new record.
View

Message Center Admin

Add a new record.
View

Figure 66. Message Center Admin: Add a new Record.

Insert Message Center

ID 2

Figure 67. Message Center Admin: Add a new Record form.
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Name the New Message Center

You can stop at just creating the message center, but you may wish to give it a different name. Typically people refer to 
message	centers	by	their	numerical	ID,	but	some	plants	choose	to	give	them	a	name	for	easier	identification.	The	name	
field	isn’t	available	when	creating	a	message	center,	so	you	have	to	go	back	into	the	edit	screen	to	add	the	name	after	
you create the message center.

1. Open PPS Reports> Administrator Options> Message Center Setup.

2. Click the message center ID to which you would like to add a name.

3. Enter a name into the Name	field.

4. Verify that the Action	field	is	set	to	“Update.”

5. Click the Update Button (see Figure 68). 

Add Monitoring Stations to a Message Center

You can add as many monitoring stations to a message center that you would like. The system will page through them 
eight at a time every 20 seconds. To add a monitoring station:

1. Open PPS Reports> Administrator Options> Message Center Setup.

2. Click the Message Center ID to which you would like to add monitor stations.

3. Locate the monitoring stations you would like to add in the list at the bottom of the page.

4. Click the checkboxs to the left of each monitoring station entry you wish to include.

Figure 68. Message Center Edit: Name a Message Center.
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5. Verify that the Action	field	is	set	to	“Update.”

6. Click the Update Button (see Figure 69).

Delete a Message Center

You can delete a message center by: 

1. Open PPS Reports: Administrator Options: Message Center Setup.

2. Click the Message Center ID you wish to remove.

3. Change the Action	field	to	“Delete.”

4. Click the Update button (Figure 70).

√

√

√

√

√

Figure 69. Message Center Edit: Add monitor stations to a message center.

Figure 70. Message Center Admin: Delete a message center.
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PPS Monitor

Located on the PPS Workstation computer, the PPS Monitor application communicates information between the 
PPS devices, the database, and the message centers. You need to keep this application running for the PPS System to 
function properly. Although your PPS system can continue to gather data at the individual PPS monitoring stations, the 
system can’t save the data to the database without the PPS Monitor application running. The PPS Monitor application 
also allows you to manage and monitor your PPS system. 

Access PPS Monitor
PPS Monitor is located on the PPS Workstation. The application is running at all times on the PPS Workstation (See 
Figure 71). If it is shut down the system continues to gather and collect data at the individual monitor stations, but the 
message center(s) will not get current data and the database will not update. Once the PPS Monitor application 
becomes available again, communications is restored and the message center(s) and database receive fresh data. If the 
application is not running, locate and double-click the PPS Monitor shortcut on the desktop , or open it using the 
Start menu: Start> All Programs> Softrol> PPS Monitor.

Monitor PPS Devices
The PPS Monitor Status Screen defaults to the PPS Devices tab (see Figure 71). From this tab you can see the status of 
all of your PPS devices. Each device is represented as a row. For each device you see several properties:

•	 Name- the device name,
•	 Code- the unique identifying number,
•	 Status- one of 8 possible status types (See Table1 for a complete list of statuses.), 
•	 Last poll- the last date and time the system received data from the device,
•	 Address- the network IP address,
•	 Active- two options: active and nonactive,
•	 Updated- the last software update on the device,
•	 Version- the current version of the software on the device,
•	 Last Record- the ID of the last record received from the device, and
•	 Type- nine possible types (see PPS Device Types on page 53 for a complete list of types).

Figure 71. PPS Monitor Status Screen.
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Table1.

Status Codes and Required Actions

Code Description Color Required Action
0 Unknown/

Communications Error
Red Touchscreen is off-line or has failed to correctly respond to 

requests for data. To correct this:
•	 Verify that the Ethernet cable is connected.
•	 Ethernet cable is damaged or cut. Disconnects are likely 

place for damage.
•	 Hub port has gone bad. Try a new port.
•	 If multiple boxes are off-line then check for hub failure.

1 Operating Normally White None
2 Diagnostic Mode Red None.
3 Setup Mode Red Touchscreen is currently in setup mode. Exit out of setup mode.
4 No Work Condition Red Employee hit the “No Work button” This status remains until the 

employee removes their card or signs into a task.
5 Maintenance Mode Yellow Maintenance tag selected.
6 No Operator Yellow No SmartCard detected.
7 Alarm/Error White Damaged PPS Monitoring Station. Repair or replace touchscreen.
8 Change Customer or 

Task
White An employee just inserted a card or selected a task.

PPS Device Types

Your plant may use the classic style, the new touchscreen, or a combination of both classic and touchscreen. Although 
different	in	appearance,	either	device	is	capable	of	serving	many	different	functions.	The	device’s	configuration	
settings	determine	its	type.	You	can	configure	them	into	three	types:	time	clock,	daywork,	or	a	standard	pacing	device.	

Time Clock

When designated as a time clock the device tracks the employee’s time. The system recognizes an employee’s on 
or off clock status when they insert their card. The device then updates the database with either a start or end 
time. 

DayWork and Manual Count

A	device	designated	for	daywork	tasks	allows	employees	to	insert	their	card	and	select	one	of	the	predefined	
daywork tasks. When the employee reinserts their card into that same touchscreen (or any other PPS device), it 
automatically logs them off of their previous task and records their time on that task.

The same touchscreen can also manage manual count tasks. Like the daywork task, the system logs them into 
the manual task of their choice. After beginning a manual count task, when they insert their SmartCard again, the 
system logs them out of the task and prompts them for their count. 
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Pacing Device

Although they may also support daywork and manual tasks, production pacing devices track an individuals or a 
teams	productivity	at	a	task	at	a	specific	workstation.	These	devices	may	have	an	external	four	or	eight	card	read-
er attached to allow simultaneous logins by team members. They also interface with some production equipment 
to monitor counts. The device communicates with the individual or team letting them know if they fall below 
production goals. This allows them to adjust their speed to maintain standards.

Configurations	on	Team	Stations	may	block	the	start	of	tasks	that	require	a	set	number	of	people	to	log	into	the	
device. Others default to tasks based on the number of employees logged into the touchscreen and adjusts the 
production rates accordingly.

Table2.

PPS Device Types

Type Description Examples

1 Time Clock: Records start and end work times for 
employees.

2 Team Pacing Device: Automatic count collection using a 
four or eight card reader to record team production rates. 
Restricts tasks based on the number of cards inserted into 
the Team Station. 

Multi-lane ironer, soil sort belt with 
hamper dumper, any task where more 
than one person performs the task

3 Production	Pacing	Device:	The	standard	configuration	
supports automatic or manual counts and daywork tasks. 

Mat roller, towel folder, single person 
tasks.

4 Cost	Center	Station:	A	touchscreen	configured	for	daywork	
and manual tasks only.

Repairs, maintenance, janitorial, garment 
quality control, no work 

5 Scale Station: Single or team production device that attaches 
to a scale. This device type measures productivity based on 
weight of the products processed. 

Soil lift station, Clean lift station, soil cart 
station, clean cart weight station

6 Bulk Fold: For use with barcode scanners and software on 
the PC to measure and audit the manual fold area.

Bulk fold and tie station

7 Department Device: Set up for one task based on number of 
users. Uses tasks 1–8 only, disabling the hot keys and counts 
on stain and mend. 

Automated sorting system

8 Cart Build Device: Used to track cart production, the device 
uses a Team Station, barcode scanners, and touchscreen. As 
operators scan the barcodes for completed cart builds the 
device credits their production counts.

9 Team Device: Same as a team pacing device, but it 
automatically switches between tasks 1–8 based on the 
number of operators.

Multi-lane ironer, soil sort belt with 
hamper dumper, any task where more 
than one person
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PPS Monitor Status Screen

Device Count 13
Inactive Devices (12) not shown

Show All Devices

PPS Devices Monitor Log Error Log Settings

Properties

Staus

Online

Figure 72. PPS Monitor Status Screen: Settings.

Device Properties

You can manage the device settings directly from the PPS Monitor Status Screen. It is important to note that any 
changes you make do not actually apply until you update the device. See Update A Device on page 56 for more 
details on updates and initializing devices. 

If	you	plan	to	make	changes	to	the	device	configuration	settings,	stop	PPS	Monitor	prior	to	entering	the	device	
properties. To access the PPS device properties window:

1. Click the Stop button on the PPS Monitor Status Screen. 

2. Right-click the device you would like to modify.

3. Select Properties	from	the	fly-out	window	(see	Figure	72)	to	open	the	PPS Device dialog window.

4. Make your changes* and click Apply to save the changes.

5. Use the Update Device tab to send the changes to the device (see Update A Device on page 56).

6. Click OK to exit the dialog.

7. Click Start.

*The PPS Device dialog window is the same window that is used in system setup. For a complete description of the 
tabs,	fields,	and	functionality	see	Add a New Device to PPS Monitor on page 37. 
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Update A Device

Once you’ve made all of your changes, you need to update the device. Before updating the device you need to stop PPS 
Monitor by clicking the Stop button at the bottom of the PPS Monitor Status Screen (see Figure 73). Switch to the Update 
Device tab. The tab contains two options: Update Device or Initialize Device.

•	 Initialize Device: Initializing a device removes all of the devices previous settings and rewrites the settings. 
Only do this when the device is not in use. Initializing a device while it is in use deletes all of the 
production data from the box. You can’t recover this lost data. 

•	 Updated Device: When using this option you select which settings get updated by checking the boxes next to 
the individual items. You can safely update a device while it is in use; although, changes don’t take effect until 
the operator ends the current task.

For a new device:

1. Stop PPS Monitor.

2. Select Initialize Device.

3. Click Begin (see Figure 74).

Stopped

Figure 73. PPS Monitor Status Screen: Click Stop before updating or 
initializing a PPS device.

Figure 74. PPS Device dialog: Update Device tab.
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Modify a Device

Once a device is added to the system you can modify all of its settings directly from the PPS Monitor Status Screen.

1. Click Stop on the PPS Monitor Status Screen (see Figure 73 on page 56).

2. Right-click the device you would like to modify.

3. Select Properties	from	the	fly-out	menu	(see	Figure	75).	

4. Make and apply your changes (for more information about the available options see Add a New Device to PPS 
Monitor on page 37).

5. Select the Update Device tab. 

6. Select Update Device and uncheck any settings you do not want to update. (If you use the Initialize option the 
system will rewrite all of the settings, any unsaved data on the device is lost. Do not use the Initialize option if 
the device is in use).

7. Click Begin. The PPS System sends the updates. If the system is in use, the settings will not take effect until 
the operator changes tasks or logs out of the device.

8. Once the update completes, click OK to close the dialog box.

Show or Hide Inactive Devices 

You can choose to show or hide inactive devices. 

1. Click the Stop button on the PPS Monitor Status Screen.

2. Click the text Show All Devices or Hide Inactive Devices in the top-center-left of the window.

3.  Click the Start button.

Figure 75. Right-click a device and select Properties.
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Removing a Device (Deactivate)

The PPS system does not allow you to remove a device from the PPS Monitor system. Once added you can set the 
device to inactive on the PPS Monitor Status Screen. 

1. Click the Stop button.

2. Right-click on the device you would like to remove and select Properties	from	the	fly-out	menu	(see	Figure	75).

3. Uncheck the Active checkbox.

4. Click Apply and then OK to close the dialog box.

5. Click the Refresh button in the lower left corner of the PPS Monitor Status Screen.

6. Click the Start button.

Activate a Device

If you want to change the status of an inactive device:  

1. Click the Stop button.

2. Click Show Inactive Devices.

3. Right-click on the device you would like to activate and select Properties	from	the	fly-out	menu	(see	Figure	75).

4. Select the Properties tab (if not already selected).

5. Click to check the Active checkbox.

6. Click Apply and then OK to close the dialog box.

7. Click the Refresh button in the lower left corner of the PPS Monitor Status Screen.

8. Click the Start button.

Adjusting PPS Monitor Settings
Using the PPS Monitor Settings tab you can set global parameters for polling and read intervals, set automatic restart, 
set logging options, display options, and set up the message center IP address. To access the settings options press the 
Settings tab on PPS Monitor Status Screen (see Figure 76). 
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Set the Default Polling and Read Interval

Although you can modify the default polling and read intervals for each device (see Status Tab: Adjusting the Poll and 
Read Intervals on page 42), you can also set default values in PPS Monitor.

The Poll Interval is how frequently the system is going to ask the devices for updated statuses. This is information 
such as, who is logged into the device and what task he or she is doing. The default is 60 seconds.

The Default Device Read Interval is how frequently the system goes to the device and pulls detailed production data 
from the device. This is data such as counts and duration. The default is 360 seconds.

Disable Internal Processing - Use SQL processing instead.

Default Device Polling Interval
Default Device Read Interval

seconds

seconds

60
360

Settings

Unload

Save

Start

Automatic restart if Monitor has
been stopped. Enter 1-120

Figure 77. PPS Monitor Status Screen: Settings. Changing the default device polling and read intervals.

Settings

Figure 76. PPS Monitor Status Screen: Settings.
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To change the defaults:

1. Select the Settings tab on PPS Monitor Status Screen.

2. Click the Stop button.

3. Change the number of seconds for either interval (see Figure 77).

4. Click Save.

5. Click Start.

Set the Automatic Restart Timer

Adjusting the PPS Settings or the device settings requires that you stop (unload) PPS to apply or make the changes. 
You may forget to click the Start	button	when	you	finish.	An	entry	of	zero	is	not	allowed	in	the	Automatic Restart 
field,	but	you	can	set	values	up	to	120	minutes.	If	you	use	a	value	of	15	minutes	or	less,	the	system	will	retain	your	
value. If you use a value greater than 15 minutes, on restart the system will reset the value back to the 15 minute 
default. To change the automatic restart:

1. Chang the number of minutes in the Automatic Restart	field	(see	Figure	78).

2. Click Save. 

Unload

10Automatic restart if monitor has
been stopped. Enter 1-120. 

minutes

10Automatic restart if monitor has
been stopped. Enter 1-120. 

minutes

Start Start

Save

Disable Internal Processing - Use SQL processing instead.

Figure 78. PPS Monitor Status Screen: Automatic Restart.
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View Current PPS Monitor Record Processing Data

PPS Monitor retrieves production data from the monitor stations based on the Read Interval ( see Set the Default 
Polling and Read Interval on page 59). It gathers the data and writes it to the database. You can view the last record 
processed, how many records need processed, and the interval in seconds that PPS Monitor attempts to write the 
records (see Figure 79).

Change the Record Process Interval

To change the Record Process Interval:

1. Click the Stop button.

2. Change the Record Process Interval.

3. Click Start.

Last PPS Device Record Processed

Records to process

Record Process Interval seconds

43047

230

100

Unload

Save

Disable Internal Processing - Use SQL processing instead.

Start

Last PPS Device Record Processed

Records to process

Record Process Interval seconds

43047

230

100

Automatic restart if Monitor has
been stopped. Enter 1-120.

Figure 79. PPS Monitor Status Screen: Record Processing.
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Using PPS Monitor Stations

The workers use the PPS Touchscreen monitor stations to record and monitor their performance (see Figure 80). 
When an employee, or employees, log into a station and select a task, the station monitors their performance. 
Depending	on	the	workstation	and	the	touchscreen	configuration	settings,	the	monitoring	station	either	gathers	
information automatically from the monitored equipment (pacing device), asks for counts when a task completes 
(manual tasks), or simply logs duration spent on the task (daywork tasks).

Each work center with pacing devices have either one touchscreen for each worker or one touchscreen with a Team 
Station. A cost center may support the options to work as a team or individually. The Team Station allows up to four 
or eight employees to log into the same monitoring station. Team Stations restrict the task selections based on the 
number of workers logged into the station. 

 

Figure 80. PPS Monitor Station.
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Figure 81. PPS Team Station



63

PPS

Softrol Systems Inc. Softrol.com

Logging In
The procedure for logging on to a PPS touchscreen is the same for all PPS touchscreen workstations. The monitor 
station displays the idle screen while it waits for a worker to log in. The worker inserts their card, and the system gives 
them choices of tasks based on the cost center and their authorizations, or the system immediately logs them into an 
automatic task. 

Log into a Manual or Daywork Task

When logging into a PPS touchscreen monitor station for a manual or daywork task:

1. Insert a SmartCard into the card slot on the left side of the PPS device (see Figure 82).

2. Wait for the monitor station to read the card (follow system prompts).

3. Select your task (see Task Selection (Manual and Daywork Tasks) on page 63).

4. Remove the card only when instructed to do so after selecting a manual or daywork task.

Task Selection (Manual and Daywork Tasks)

The system restricts task selection based on the monitoring station designation (daywork/manual, time clock, or 
automatic ), and the cost center. Once a worker inserts their card, the system displays all of the cost center’s tasks 
in a vertical and a horizontal tiled list (see Figure 83). 

Figure 82. PPS Monitor Station with SmartCard inserted.
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Swipe options (gestures)

The screen displays task tiles in a horizontal and vertical orientation. To select a task:

1. Insert your SmartCard.

2. Leave the card in the touchscreen while it generates your task options.

3. Using	your	finger,	swipe	up	and	down	or	left	and	right	to	scroll	the	list.

4. Tap the task tile with the desired task.

5. Wait for the system prompt before removing the card. 

Manual Entry

If you know the task number you can tap the text, “Touch to Manually Enter Task #” to bring up the touchscreen 
keyboard. Input the task number and tap the Enter button (see Figure 84).

Figure 83. Touchscreen: Swipe the tiles to scroll.
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Figure 84. Tap “Touch to Manually Enter Task #” to bring up the keyboard and enter a 
task number.
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Touchscreen with a Team Station

Most	Team	Station	boxes	serve	a	specific	task,	and	workers	logging	into	these	monitoring	stations	automatically	 log	
into	the	stations	specified	task	with	no	other	interaction	needed.	As	workers	come	and	go	from	the	work	center,	the	
monitoring station auto adjusts the current task selection based 
on the number of cards in the Team Station. For example, the soil 
sort Team Station contains three SmartCards. The monitoring 
station automatically logs all three workers onto a soil sort task 
that requires three workers. If another worker joins the three by 
inserting their SmartCard, the monitoring station automatically 
logs off the original three workers from the three person task 
and logs all of the workers onto a four person task. When a 
worker removes their card, the system adjusts to the task based 
on the number of remaining workers. If a worker removes the 
SmartCard in position one, the system logs off everyone until a 
card is inserted back into position one.

Touchscreen monitoring stations that use Team Station boxes do not use RFID card reading technology; therefore the 
touchscreen installation should prevent workers from using the RFID card slot on the left side of the touchscreen. 
Instead of the RFID card reader slot on the touchscreen, workers insert their SmartCards into the Team Station. You 
can get Team Stations that accommodate up to four or eight workers at a time. Softrol can accommodate larger teams 
using two touchscreen monitoring stations with two Team Stations.

Logging into a Team Station

Logging into a Team Station only requires that the employees insert their SmartCards into one of the slots in the 
Team Station. The system requires that slot number one contain a card before it reads any other card in the other 
slots (see Figure 86). Workers leave their cards in the station while they work. 

Team
     Station

1 1
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6 6
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Figure 85. PPS Monitor Station with Team Station
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Figure 86. Team	Station	SmartCard	placement.	The	correct	team	stations	both	have	a	SmartCard	in	slot	one.	The	configuration	of	the	remaining	
slots	doesn’t	matter	as	long	as	there	is	a	card	in	slot	one.	The	wrong	configured	Team	Station	does	not	have	a	card	in	slot	one.	The	system	will	not	
read the other cards until there is a card in slot one.
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Logging into Bulk Fold Team Stations

Team	Stations	for	a	bulk	fold	machine	requires	a	slightly	different	card	configuration	before	the	monitoring	station	can	
start the bulk fold task. The system does not start the task until workers insert their SmartCards into slots one and eight 
(see Figure 87). The system requires that at least one feeder to insert their card into slot one. The system defaults to slot  
eight for the receiver or auditor position. This is the minimum requirements for a bulk fold task, but you can have multiple 
workers on the feed side.

You	can,	if	needed,	change	the	slot	for	the	auditor.	For	information	about	configuring	the	bulk	fold	monitoring	station	and	
changing the slot used by the auditor see Bulk Fold Setups Tab on page 41.

Logging Off a Task

Logging off a task depends on the type of task: daywork, manual, or automatic. Always follow system prompts, and do 
not remove your SmartCard before the system says it is okay to do so. 

Daywork Task

You can end, or log off a daywork task by inserting your SmartCard into any PPS device. The system reads the card 
and automatically logs you off the current task. The system then prompts you to either remove your card or select 
a new task. If the monitoring station is an automatic monitoring station, the station ends the current daywork 
task and logs you onto its designated task. A monitoring station used as a time clock ends the task, and logs the 
employee out (no longer on the clock).

Manual Task

Like the daywork task, you can log out of a manual task using any PPS monitoring station except monitoring 
stations with a Team Station or time clock monitoring stations. Inserting a SmartCard into a team station or a time 
clock will end the task, but the count defaults to zero. When you insert your SmartCard into a manual/daywork 
designated monitoring station the system prompts you for the task count. Failing to provide a count results in a 
count of zero. Once the system ends the task, it prompts for a new task or for you to remove your card.

Automatic Tasks

To end an automatic task, pull your card out of the touchscreen or Team Station. No further action is necessary. The 
system may also automatically log off a worker that remains idle to long (see Adjust the Setups Tab on page 39).
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Figure 87. Bulk Fold team station 
correct card arrangement.
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Managing Performance

Once logged into the monitoring station the system begins monitoring performance. Each task has parameters 
established	for	the	acceptable	production	rates	in	the	setup	configuration	(see	Task	Parameters	on	page	19).	When	
the worker, or team of workers produce at or above acceptable production rates, the touchscreen monitor display 
turns green (see Figure 88). If production slips below acceptable levels the display turns red to inform the worker to 
pick up their pace (see Figure 89).

The screen color only applies to the current task. A worker can show red on the current task but still have a 
satisfactory	daily	efficiency	rating.	The	worker	can	see	their	daily	efficiency	on	the	right	side	of	the	touchscreen	
monitor.	The	Daily	Count	and	Daily	Efficiency	totals	do	not	include	counts	and	efficiency	from	the	current	task.	

Mend and Stain Counts

If your plant tracks stain and mend counts, workers can tap the Stain or Mend icons when they pull an item from their 
work stream for these purposes. You may want to acknowledge the piece count for items pulled for stains or mending. 
See Adjust the Setups Tab on page 39 for more information about enabling stain and mend counts.

Maintenance Request

Pressing	the	Maintenance	icon	on	the	touchscreen	stops	production	and,	if	configured,	sends	a	message	to	
maintenance stating the machine needs immediate repair.

No Work

This icon, when pressed, sends a message to management that the work center doesn’t have any product.

Favorites

The Favorites icon is a shortcut to a list of common tasks for that monitoring station. To set up the favorites see Adjust 
the Setups Tab on page 39.

Figure 88. PPS Monitor Station. Satisfactory production level turns 
the screen green.

Figure 89. PPS Monitor Station. Unsatisfactory production level 
turns the screen red.

Figure 90. Interactive icons on the PPS touchscreen.
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Replacing a PPS Monitor Touchscreen.
Occasionally you will have the need to replace a PPS station touchscreen. Each touchscreen needs set up on your 
network,	the	current	PPS	software	installed,	and	configured	for	your	purposes.	Softrol	includes	the	PPS Touchscreen 
Installation Guide with a replacement device. You can also download the instructions from the Softrol PPS Support 
Website http://support.softrol.com/CustSites/Pulse/MANUAL-PPSX-INSTALLATION.pdf

Powerful Tools for Better Performance

Productivity

PPS: PulseNet Production System 
Touchscreen Installation Guide

Figure 91. PPS Touchscreen Installation Guide
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Other Software

The PPS system consists of many different software and hardware components. Some of these additional programs 
you may never need to access, and others only rarely. Not all systems use or need all of the following software 
programs. These additional programs include software to manage bulk-fold systems, email alerts. multi-team stations, 
and maintenance alerts.

BulkFold Communications Module
This software application is necessary to manage most bulk fold systems. A typical bulk fold setup contains a number 
of stations with barcode scanners and an audit station at the end with a barcode scanner. The application takes the 
scan data from the stations, processes it, and updates the database and the PPS monitoring station with the data. If 
the software is not running, the database doesn’t receive the data, and the system will not report accurate data (see 
Figure 92).

BulkFold Communications Module

File

Node Scanes
Messages

Timer ValueClose Com PortsCLR

Figure 92. The BulkFold Communications Module.
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Email Alerts
Softrol activates the email alert system on most every system. The email alert application checks the database every 
five	minutes	to	verify	communications.	The	system	logs	successful	communications	between	the	database	and	the	
PPS devices, and if a touchscreen has not responded to data requests for an hour or more (as designated in the 
application), the email alert system sends out an email message to all of the emails listed in the application. 

It is important that the Email Alert application remain active. When Softrol support gets an email update, they check 
the	system	to	determine	the	cause	of	the	communication	break.	A	Softrol	support	technician	can	fix	many	problems	
remotely.

If you would like additional email accounts added to the alerts list, contact Softrol Support. 

Figure 93. The Email Alert module.
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Reports

The reports included with PPS gives you the information you need to improve processes and increase your bottom 
line. You can gather data and quantify labor, equipment usage, and production information using PPS Reports. PPS 
Reports gathers information in real-time for:

•	 operator performance: compare performance against standards, track non-productive and idle time; and
•	 production	quantities	(calculated	pounds	and	counted	pieces)	and	efficiencies	gathered	through	task	

information.

You can monitor automatic, manual, daywork, team tasks, employees, cost centers, machine operation and work 
histories from a single source.

Key Terms
Before accessing reports, it is important that you understand the meaning of a few key terms: 

•	 Idle time: time not measured within a task parameter, yet the employee is on paid time.
•	 Earned hours:	An	employee’s	time	is	reported	in	hours	earned	to	determine	their	efficiency.	The	earned	hours	

value is based on quantity of product produced and not the time spent on a task. If the task’s production rate 
is 60 pieces an hour, then the employee gets one minute of credit for each piece completed. If they produced 
90 pieces they earn 1.5 hours.

•	 Measured hours: An employee’s actual time spent on a task.

Access
You can access the reports using the workstation PC or using a web browser from any PC connected to the plant’s 
network.

•	 From the workstation PC, open PPS Monitor and click the reports button (see Figure 94). This will launch the 
default Internet browser.

•	 From any other computer on the plant’s network, type the URL provided to you during install. The URL points 
to the web server: http://<Sever IP address>/ppsreports/login.asp

Reports

Figure 94. PPS Monitor home screen: Reports
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Complete the login using the user name and password supplied to you during the installation. If you do not have login 
information contact Softrol Support (see Support: Get Additional Help on page 84).

Once	logged	into	PPS	Reports	you’ll	find	many	options	for	organizing	and	viewing	your	production	data.	The	
reports sections used most often include the Plant Level Reports, Dept/Cost Center Reports, and Operator Reports 
(see Figure 96).

Figure 95. PPS Reports Login page.

Daily Operator Performance Summary

Time Clock Review

Employee Lookup

Underachievers Report

Employee Productivity Summary

Operator Reports

Daily Operator Performance Summary

Time Clock Review

Employee Lookup

Underachievers Report

Employee Productivity Summary

Operator Reports

Daily Operator Performance Summary

Time Clock Review

Employee Lookup

Underachievers Report

Employee Productivity Summary

Cost Center Summary: By Item

Cost Center Summary: By Device

Cost Center Week Summary

Daywork Summary Report

Machine Maintenance Review

Dept/Cost Center Reports

Cost Center Summary: By Item

Cost Center Summary: By Device

Cost Center Week Summary

Daywork Summary Report

Machine Maintenance Review

Dept/Cost Center Reports

Plant Level Reports

Management Report for Labor

Daily Plant Production Summary

Graph Production By Cost Center

Pieces & Pounds Report

Quality Process Summary

Plant Level Reports

Management Report for Labor

Daily Plant Production Summary

Graph Production By Cost Center

Pieces & Pounds Report

Quality Process Summary

Figure 96. The PPS Reports menu.
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Setting Your Reports Date and Shift Parameters

When you open a report, the system prompts you for date and shift information along with some other parameters 
that change for each report (see Figure 97). The selection of date and shift sets date and time parameters on your 
returned data. PPS Reports gathers the data based on the work performed by the employees assigned to a shift. 

Selecting Dates

Your PPS Reports date selection defaults to the current date. You can modify it to another date, or you can select a span 
of	dates.	A	day	in	PPS	spans	from	the	beginning	of	first	shift	to	the	beginning	of	first	shift	the	following	day.	Notice	
in Figure 98 that each day starts at 4 AM and ends at 4 AM on the following calender day. Each plant sets their shifts 
based on their actual shifts. Although some plants only have one or two shifts the system requires that you designate 
three non-overlapping shifts with no gaps. The three shifts when combined add up to exactly 24 hours. 

When you select a date in PPS Reports, you get the data back based on the plants operating day. An employee’s 
productivity	is	reflected	in	the	report	for	the	day	that	their	time	record	started.	If	an	employee	clocks	in	after	midnight	
but	before	the	start	of	first	shift	their	time	is	attributed	to	the	previous	day.	This	can	impact	your	reports	if	your	
employees	tend	to	clock	in	early	on	first	shift.

Select Dates

Select Shift

Select Item

1st Shift

2nd Shift

3rd Shift

Single Employee

Select All

Home Cost Centers

Employees

Don’t show badge
Don’t show name.

From:

To:

Employee Productivity Summary

Select Dates

Select Shift

Select Item

1st Shift

2nd Shift

3rd Shift

Single Employee

Select All

Home Cost Centers

Employees

Don’t show badge
Don’t show name.

From:

To:

Figure 97. PPS Reports date and shift selections.

Monday Tuesday

4 A.M. 12 P.M. 8 P.M. 4 A.M. 12 P.M. 8 P.M.

First Shift
Second Shift
Third Shift

4 A.M.

Wednesday

12 A.M. 12 A.M. 12 A.M.

Figure 98. The	definition	of	a	day	in	PPS	Reports	is	the	24	hour	period	following	the	beginning	of	first	shift	to	the	end	of	third	shift.	Each	day	in-
cludes three non-overlapping shifts with no gaps.
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Selecting Shifts

You must select at least one shift when generating a report. By selecting a shift or shifts you:

•	 Limit the data based on employee shift assignment. Each employee is designated a shift in the system. 
Regardless of when they did the work, any productivity for an employee is assigned to their designated shift. 

•	 Set	a	start	time	for	your	reports.	The	begin	time	of	the	earliest	shift	you	selected	on	the	first	day	of	your	date	
selection becomes your report’s start time. 

•	 Set an end time for your reports. The end time of the last shift you selected on the last day of your date 
selection becomes your report’s end time.

PPS Reports only gives productivity information based on the employees entire time worked; the data included may 
include more than you expect or less than you expect.

For	example,	you	want	to	capture	data	for	first	and	second	shifts	on	a	particular	Monday.	In	Figure	46	the	light	blue	
highlight	represents	the	data	collected	for	the	report.	In	this	example	first	shift	starts	at	4:00	A.M.	and	second	shift	
ends	at	8:00	P.M..	The	report	pulls	the	data	for	all	employees	assigned	to	first	and	second	shifts	that	worked	during	the	
time span of the two shifts. 

Jon	and	Debbie	both	normally	work	first	shift,	but	on	this	particular	Monday	they	both	worked	third	shift.	George,	
normally	on	third	shift,	worked	first	shift.	Debbie	arrived	a	couple	minutes	early,	and	Jon	arrived	late.	Because	Debbie	
is	designated	a	first	shift	employee	and	a	small	portion	of	her	time	occurred	during	the	times	established	by	the	first	
and second shift selection, all of Debbie’s productivity is included in the report. Because none of his clocked hours 
occurred	during	first	or	second	shift,	Jon’s	productivity	is	excluded	from	the	report.	Because	George	is	assigned	to	
third	shift,	his	productivity	is	excluded	from	the	report	regardless	that	all	of	his	productivity	occurred	during	first	and	
second shift.

Monday Tuesday

4 A.M. 12 P.M. 8 P.M. 4 A.M.

Greg’s clocked time
Jon’s clocked time
Debbie’s clocked time 
Data Captured
First Shift
Second Shift
Third Shift

Figure 99. One	day	selected	for	first	and	second	shifts.	
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To include Jon’s productivity in the report you can either expand your shift selection to include third shift or you can 
expand your date selection to include Tuesday. Notice in Figure 100 that Jon’s data is included because it falls between 
the	start	of	the	first	shift	on	Monday	and	the	end	of	the	second	shift	on	Tuesday.	

Monday Tuesday

4 A.M. 12 P.M. 8 P.M. 4 A.M. 12 P.M. 8 P.M.

Greg’s clocked time
Jon’s clocked time
Debbie’s clocked time 
Data Captured
First Shift
Second Shift
Third Shift

Figure 100. Two	days	selected	for	first	and	second	shifts.	
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Reports of Interest
PPS	Reports	contains	many	reporting	options.	We	encourage	you	to	explore	them	all,	but	most	PPS	users	find	that	the	
Employee Productivity Summary, Daily Operator Performance Summary, and Daily Plant Production Summary	fits	most	
of their needs. 

Employee Productivity Summary

The Employee Productivity Summary, located under the Operator Reports section of the PPS Reports menu, offers 
a one line summary of each employee’s performance for the dates and shifts selected (see Figure 101). You can drill 
down to detailed employee records for breakdowns of each employees productivity.

Earned Hours, Measured Hours, and Percent Efficiency 

The columns under the green headings include Earned Hours, Measured Hours, and the Percentage of Efficiency for 
each employee. 

Earned Hours:	The	Earned	Hours	column	is	calculated	using	the	piece	counts.	If	the	system	has	the	task	defined	
to produce a certain quantity per hour, then that quantity equals one earned hour. 

Measured Hours: Measured hours is calculated by subtracting non-productive time from the Clock Hours 
(non-productive time equals Non-Productive Allowed minus Non-Productive Hours). This is actual time the em-
ployee spent actively logged into tasks during the reporting period. 

Percent	Efficiency	(%	Eff):	Divide	Earned	Hours	by	the	Measured	Hours	to	calculate	the	percent	efficiency.	This	
is	the	employee’s	efficiency	for	the	time	period.	This	does	not	take	into	account	any	daywork	tasks	performed.

Daywork Hours

An employee earns daywork hours (yellow heading) for tasks that don’t result in a measurable end product. 
Examples	of	daywork	tasks	include	cleaning	the	floor	and	maintenance	tasks.	Daywork	hours	do	not	calculate	
into employee Percent	Efficiency	(green heading) values, but they do apply to the Overall Effectiveness (blue 
heading) value.

Non-Productive Hours Used and Allowed

The Non-Productive Hours column (red) is the actual non-productive time used (If the employee didn’t use all 
of the their non-productive hours the value can appear as a negative number). This is the amount of time the 
employee spent on the clock without logging into a task. The other column, Non-Productive Hours Allowed, is 
the number of non-productive time allowed during the entire reporting date span. To set your non-productive 
hours allowed see Budgeted, Non-productive Time Set Up on page 44.

Available Work Hours

The Available Work Hours is the Measured Work Hours excluding the Non-productive Allowed time. This 
value is used with the Total Earned Hours to calculate the Overall Effectiveness (blue section).
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Total Earned Hours

The Total Earned Hours includes the Earned Hours (green section) and any Daywork Hours earned (yellow 
section). This value is used with the Available Work Hours to calculate the Overall Effectiveness (blue section).

Overall Effectiveness

The Total Earned Hours divided by the Available Work Hours gives you the Overall Effectiveness. This 
percentage allows you to quickly see your top performers.

Daily Operator Performance Summary

The badge numbers to the left on the Employee Productivity Summary provide you with links to detailed reports about 
each employee. Clicking the badge number* brings you to the Daily Operator Performance Summary (see Figure 102). 
The Daily Operator Performance Summary gives the same information as the Employee Productivity Summary, but it 
contains greater detail about the operator’s activities and performance. The colored rows in this report map back to 
the matching colored columns in the Employee Productivity Summary.

* You can also access this report directly from the main menu.

Productivity Tasks

The Productivity Task section maps back to the green columns on the Employee Productivity Summary report. 
This section breaks down the employee’s productivity by each task they logged. You can see exactly what tasks 
and	counts	contributed	to	the	task	efficiency	score.	

Employee Productivity SummaryBack
Report Date: 01/16/2014 To 01/20/2014

Shift 1,2,3
Date: 1/27/2014

Badge Name
Earn.
Hrs % Eff 

Daywork
Hrs

Non-Prod
AllowedClock Hrs

Non-Prod
Hrs Avail Work Hrs

Total Earn
Hrs

Overall
Effectiveness

Meas
Hrs

Figure 101. Employee Productivity Summary report.
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Daily Operator Performance SummaryBack
Previous Day
Report Date: 10/6/2014 3:06:56 AM To 10/10/2014 12:52:16 PM

Home Next Day

SMITH, Jon (7) Softcard# 80648 Home CC# 1000 Time Clock Work Hist Graph

Productive Tasks

Productive Tasks Total
Daywork Tasks

Productive Task Total

Non-Productive Time

Non-Productive Time Total
Overall Effectiveness

Available Work Hours

Total Earned Hours
Overall Effectiveness

Idle Time

Cost Center Task #Occ Stnd Qty Ern Hrs Meas Hrs % Eff

Non-Prod Allowed

Clock Hours
Non-prod Allowed

Earned Hours
Daywork Hours

Report Total for Productive Tasks

Report Total for Daywork Tasks:

Report Total for Non-Productive Time:

M Hrs E Hrs % Eff

M Hrs

Idle Time
Mach Off

Non-Prod Allowed
Total

Plant Time Allocation
Clock Hrs

Non-Prod
Allowed

Avail.
Hrs Hrs Hrs

Ern Daywork Alloc.
% Alloc.

Back

Hrs

Date: 10/23/2014

Figure 102. Daily Operator Performance Summary report.
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Daywork Tasks

The Daywork Tasks section breaks down the daywork tasks logged by the employee during the reporting period. 
The totals for the daywork tasks maps to the daywork tasks on the Employee Productivity Summary.

Non-Productive Time

The Non-productive Time is time an employee spends that is not associated with a task. The total non-produc-
tive time is reduced by the non-productive time allowed.

Daily Plant Production Summary

The Daily Plant Production Summary provides production information based on production items. You can generate 
your report by date range, shifts, departments, and cost centers. If you don’t select any departments the system 
includes all departments and their cost centers by default. The report gives you information on the items, number of 
pieces,	measured	hours,	earned	hours,	and	department	efficiencies.

Back
Previous
From: 10/6/2014 To: 10/10/2014 

Next
Date: 10/23/2014

Dept/Cost Center Item Total
Pieces

Meas.
Hrs.

Ern.
Hrs. Eff %

Productive Tasks
Soil Department

Cost Center Total:

Sub Total Productive Tasks

Non-Productive Tasks

Total Department Hours

Productive Tasks
Production Department

Cost Center Total:

Cost Center Total:

Cost Center Total:

Sub Total Productive Tasks

Productive Tasks
Specialty Department

Total Department Hours

Cost Center Total:

Non-Productive Tasks

Sub Total Productive Tasks

Total Department Hours

Non-Productive Tasks

Sub Total:

Report Totals

Productive Tasks:

Non-Productive Tasks:

Report Totals

Total
Pieces

Total
Eff%

Ern
Hrs.

Meas.
Hrs.

Daily Plant Prodution Summary

Figure 103. Daily Plant Production Summary. Each department is broken out to show individual production rates. The report gives combined report 
totals at the bottom of the page. 
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The report groups information by department and cost center. For each cost center the report provides the items 
processed	at	the	cost	center	with	breakdowns	by	the	total	pieces,	measured	hours,	earned	hours,	and	efficiency	
percentage. The report displays the subtotals for each cost center. The report then shows the department’s totals for 
productive tasks (measurable counts) and non-productive tasks (daywork) (see Figure 103).

Clicking on an individual item name breaks the data down into the employees and their contribution to the totals (see 
Figure 104). Clicking further brings you to the Daily Operator Performance Report for the selected employee.

Correcting Reports

Sometimes when viewing reports you will notice some numbers that do not make sense. Typically these extremely 
high or low numbers results from an employee logging in and out of tasks incorrectly. The example above is an 
example of an invalid employee entry. The operator, Keith, entered a manual count of 200, but he only logged 
nine	minutes	on	the	task.	Kieth’s	entry	of	200	in	9	minutes	gives	a	6666.7%	efficiency	rating.	Since	the	standard	
production rate for this task is 20 per hour either Kieth entered the incorrect count or he didn’t log into the task 
until near the completion of the task.

Bags - Hang **
Mats - Roll **

Anthony Smith

Keith Briggs

CRT Unwind **

(137) Pull Mats
(138) Set Up Mat Carts

(138) Set Up Mat Carts

   6        0.02   0.02       100.0%
     1.339        6.08         47.77       785.7%
 Std
  75     523      3.18         6.97      219.2 %
  20     616      2.75       30.80        1120%
 Std
  20    200       0.15       10.00     6666.7%
          83        2.65   0.42         15.8%

Figure 104. Daily Plant Production Summary. Expanding the item gives details about who and exactly what 
tasks they completed to contribute to the numbers.

(138) Set Up Mat 3

(42) Roll Mats 5

Carts

(138) Set Up Mat 3

(42) Roll Mats 5

Carts

Figure 105. Daily Operator Performance Summary. Clicking an employee’s name form within the Daily Plant Performance opens the Daily Operator 
Performance Summary.
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Clicking Keith’s name generates a breakdown of his activities during the reporting period in the Daily Operator 
Performance Summary (see Figure 105). The report shows that Keith logged three instances of the task during the 
reporting period. Clicking on the Work History link at the top right of the report allows you to see the details.

The Work History page shows that Keith logged times of 8, 1, and 0 minutes for the three occurrences of the task 
(see Figure 106). It is impossible that Keith did the amount of work reported in the 9 minutes reported. After in-
vestigating	the	situation	you	may	find	that	either	the	time	reported	is	incorrect	or	the	count	provided	is	incorrect.	
You can correct this by clicking the edit link in the Action column (see Figure 106).

Edit or Delete a Work History Record

From	the	Work	History	view,	you	can	see	the	specific	
details of an employee’s activities. You can also edit 
or delete these invalid entries. To correct or delete 
the entries:

1. Click the Edit button to the left of the 
invalid entry to open the Work History 
Update screen (see Figure 106).

2. Make the needed changes to the start and 
stop times, total counts, or click Delete 
Record to remove the record all together.

3. Click Save.

Wed  10/22     3:44:17 PM     3:45:27 PM    1    (138) Set Up Mat Carts        0 / 0.00       5.00       0.02       0.0          100

Fri    10/22     3:19:09 PM     3:27:15 PM    1    (138) Set Up Mat Carts        0 / 0.00       5.00       0.13       0.1          100

Fri    10/24     3:54:24 PM     3:54:24 PM    1    (138) Set Up Mat Carts        0 / 0.00       0.00       0.00      0.0               0

Action   Device   Day     Date       Start                     Stop                       Shift   Work Task                                                      Ern Hrs     Meas Hrs  Task Hrs  CountMach Off
(secs/hrs)

1033

1033

1033

edit

edit

edit

edit

edit

edit

edit

edit

edit

edit

edit

Figure 106. Daily Plant Production Summary. Expanding the item gives details about who and exactly what tasks they completed to contribute to 
the numbers.

Field        Value

Id        298065

Employee ID / Department    804738 / 1

Customer ID      0
Task        (138) Set Up Mat Carts
Task Hours      0.0

Start time

Stop Time

Shift

Total Count

Machine Off Time

Delete Record

10/22/2014
3:44:17 PM

10/22/2014
3:45:17 PM

mm/dd/yyyy
hh:mm am/pm

mm/dd/yyyy
hh:mm am/pm

1

100
Production Std. 20
Earned Hours 5.00

0 seconds

Save

Figure 107. Edit a work history or time clock entry. Change Dates, times, 
and counts to correct employee mistakes.
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Add a Work History Record

If an employee forgets to log into a task, or they log into the wrong task, you can add the record. The add dialog 
lists all of the available unlogged time From the Daily Operator Performance Summary report for the employee you 
wish to add the record:

1. Click Work History.

2. Click Add in the bottom left corner of the screen (see Figure 106)to open the add dialog (see Figure 108).

3. Select the row with the Start Time you wish to use. You can modify the start time if you would like.

4. Enter the task Duration.

5. Select either a Daywork or Manual Entry task (only select one or the other).

6. Enter a Count for manual entry tasks.

7. Click Submit.

Open Times for:
To view another date press Change:

10/28/2014 6:00:00 AM to 7:28:31 AM
9:43:50 AM to 9:58:30 AM
10:00:00 AM to 3:00:00 PM

Add task for: 10/28/2014
(804670), Gulnara

Customer Start Time:
hh:mm am/pm

Duration
(Min.)

Select Daywork or Manual Entry Task
Select one only Count*

Unassigned

Unassigned

Unassigned

06:00 AM 88 Daywork

Daywork

Daywork

Manual Entry

Manual Entry

Manual Entry

10:23 AM

09:44 AM

88

14

277

Submit

Change

* Include a count for Manual Entry Tasks

Figure 108. Add a work history entry. 
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Pieces and Pounds Report by Item

The Pieces and Pounds Report by Item is a top level report that only gives you quantities based on production. No 
employee data is included in the report. You can see the number of pieces and the pounds for each item based on your 
time, shift, department, and cost center selections. At the bottom of the report you can get total counts and weights for 
the reporting period (see Figure 109).

Pieces And Pounds Report by Item
Report Date: 10/28/2014 To 11/4/2014

ItemItem Task
Name Customer PiecesMend

Cnt
Stain

Cnt
Disc
Cnt

Dry
Wt

Total
Pounds

1st
Back

Figure 109. Pieces and Pounds report. 
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Support: Get Additional Help
If	you	find	yourself	in	the	need	for	help	with	the	process,	you	have	several	support	options:

Web Support

Visit the Softrol Support website ( support.softrol.com) to get current documentation. With your support 
login	you	will	find:
•	 Product manuals, 
•	 FAQ, and
•	 Update downloads.

Telephone Support

Call 1-877- 241-7679 for Softrol‘s technical support. Site License Number may be necessary to receive 
support.

Email

support@softrol.com

Hardware Repair

A Return Merchandise Authorization (RMA) is required to return a part for repair or credit. To request an 
RMA call 1-888-763-8765 (888-SOFTROL) ext. 122 or email rma@softrol.com.

Parts

For replacement parts contact Softrol’s Parts Department between the hours of 8:30 a.m. and 5:30 PM EST at 
1-888-763-8765 (888-SOFTROL) ext. 110 or email parts@softrol.com.

Site License

Site Licenses are available for all Softrol’s automation and information networks. Please contact Softrol 
Support support@softrol.com or call 1-888-765-8765 (888-SOFTROL) ext.128
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Hardware Requirements

Besides the Touchscreens, SmartHubs, Power Hubs, Team Stations, Message Centers and cables the PPS system 
requires two PCs to operate. The minimum hardware requirements for the PCs is as follows:

Database PC Hardware Requirements
Required: 1
Minimum system requirements: 

•	 2.4 GHz or greater server class machine (rack mountable if desired)
•	 Two 100GB drives or larger (to support RAID 1 mirrored drives)
•	 RAID 1 capable (mirrored drives)
•	 8GB of memory
•	 DVD/CD-RW optical drive
•	 2 Ethernet connections 100Mbs or better
•	 LCD monitor (minimum 1280x1024 resolution)
•	 8 port Ethernet workgroup switch
•	 Local network cabling and connections

Operating systems and software:
•	 Microsoft Windows 2008 Server or later
•	 Microsoft SQL Server 2008 Release 2 or later.
•	 Open	Office
•	 PDF printer

PPS Application PC
Required: 1

Minimum system requirements:

 Hardware Platform:
•	 2.0 GHz processor PC
•	 Min 4 GB RAM
•	 Min 100 GB disk space
•	 DVD/CD-RW optical drive
•	 2 Ethernet connections 100Mbs or better
•	 LCD monitor (minimum 1280x1024 resolution)
•	 Local Network Cabling and Connections

 Operating systems and software:
•	 Microsoft Windows 7 (32bit, or 64bit) 
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PPS PC Installation Process

The following details the process for installing a PPS workstation computer. See Appendix A for software and 
hardware requirements.

Network Cards Set Up

Label the network cards on the outside of the cabinet. Name one “PPS Network,” and label the other “Corp Network.”

Change the name of the network connections:

1. Click Start> Control Panel> Network and Sharing Center>Change Adapter Settings

2. Right-click each adapter and select Rename.

3. Rename each adapter to match the corresponding cabinet labels: PPS Network, Corp Network (see Figure 
110).

PPS Network Adapter Settings

1. Right-click the PPS Network adapter and select Properties.

2. Click to select the Networking tab.

3. Uncheck Internet Protocol Version 6 (TCP/IPv6).

4. Click to highlight Internet Protocol Version 4 (TCP/IPv4).

5. Click the Properties button.

6. Select Obtain IP address automatically.

7. Click OK to apply the settings and close the Properties dialog.

Figure 110. Network Settings. Rename each adapter to match the label on the device. 
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PPS Network Settings

You need to change the settings for the PPS Network.

Set the TCP/IP Settings

1. Right-click the PPS Network Adapter

2. Click Properties.

3. Click to highlight Internet Protocol Version 4 (TCP/IPv4).

4. Click Properties.

5. Select Use the following IP address.

6. Set the IP address to: 192.168.100.100

7. Set the Subnet mask to: 255.255.255.0

8. Leave	the	gateway	and	other	fields	blank.

9. Click OK. 

10. Click OK to accept the changes and close the dialog.

Figure 111. PPS Network TCP/IP settings. 
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Disable the Firewall

1. Right-click the PPS Network Adapter.

2. Click Properties.

3. Click the Advanced tab (see Figure 112).

4. Click the Settings button in the Windows Firewall 
section.

5. Select Off on the General tab, ignoring the 
Window’s recommendations.

6. Click OK to close the Windows Firewall dialog.

7. Click OK to close the PPS Network Properties dialog.

Figure 112. PPS Network Properties Advanced tab. 

Figure 113. PPS Network Windows Firewall settings. 
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Database Setup
You need to set up PPS as a user on SQL Server.

1. Open Microsoft SQL Server Management Studio.

2. Log in using the default administrator login and password (set up during install).

3. Expand the Security folder in the Object Explorer panel.

4. Right-click on the Logins folder and select New> Login.

5. Set the Login name to: “pps”

6. Set	the	Password	fields	to:	“pps”

7. Click OK.

8. Create a directory (folder) on the root drive (usually the “D” drive) and name it “Database.”

Figure 114. Microsoft SQL Server Management Studio. Create a new login with login name “pps” and password “pps”
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Install PPS Monitor
You will need to get the most recent version of PPS Monitor from the Softrol Support site. Contact Softrol for more 
information about downloading and installing the most recent version of the application. Once installed, place a 
shortcut on the desktop to PPSMon.exe.

Restore the Database from a Backup
When you installed PPS Monitor the installer placed a database backup on the hard drive. You will now use the Restore 
features of Microsoft SQL Server Management Studio to create a new database from a backup.

1. Open Microsoft SQL Server Management Studio.

2. Right-click the Database folder in Object Explorer.

3. Select Restore Database.

4. Type “PPS” in the To database	field	of	the	Restore Database dialog (see Figure 115).

5. Select From device.

6. Click the button to the right of the From device	field.

Figure 115. The Restore Database dialog.
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7. Select File from the Backup media options (see Figure 116).

8. Click the Add button.

9. Navigate	to	D:\Softrol\PPS	Monitor\Database	and	select	the	file	pps_ititial.bak.

10. Click OK on the Specify Backup dialog.

11. Click the checkbox on the Restore Database dialog for the database you wish to restore from backup (see 
Figure 117).

Figure 116. Specify Backup dialog.

From device:

Select the backup sets to re

Restore Name

pps-Full Database

Figure 117. Restore Database restore checkbox.
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12. Click Options in the Select a Page section of the dialog (see Figure 118).

13. Verify	that	each	entry	in	the	Restore	Database	files	as	section	point	to	D:\Database

14. Click the “...” button to the right of each entry in the Restore	database	files	as	section.

15. Navigate to and select the D:\Database directory you created earlier.

16. Switch back to the General page.

17. Click OK. SQL Server will create the new database from the backup. 

Update Windows Registry

The Windows Registry needs updated. To update the registry:

1. Navigate to C:\Softrol\PPS Monitor\vb6Control

2. Double-click	the	file	named	VB6Controls.reg (for a detailed explanation of why this registry update is 
necessary, search the MS Knowledge Base for article q318597)

Test Database Connection

Verify that you have a connection to the database:

1. Open the PPS Monitor application and select the Settings> Program Settings menu prior to logging in.

2. Select the Database Connection tab (see Figure 119).

Restore the database �les as:

Original File Name File Type Restore As

pps Rows Data D:\Database\MMS.mdf

pps_log Log D:\Database\MSS_1.Idf

Figure 118. Restore Database options tab.
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Figure 119. PPS Program Settings: Database Connection.

3. Change the Server Address to the IP address of the database server.

4. Click OK.

5. Continue logging in to PPS Monitor (use the user ID and password supplied to you during the install).

6. Click OK when prompted to update the database.

7. Reopen the PPS Program Settings.

8. Select the Properties tab (see Figure 120).

9. Set the Reports Login Web Page to: http://<IP address>/ppsreports/login.asp Replace IP Address with the 
reports server IP address ( usually 192.168.100.254).

10. Set the Starting IP Address to: 192.168.100.1

11. Set the Sub Net Mask to: 255.255.255.0 

Figure 120. PPS Program Settings: Properties.
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12. Click to check Auto Start Monitor Program at this Workstation.

13. Set a Shutdown Password. This password will keep unauthorized personnel from shutting down the PPS 
Monitor application. Leaving it blank will allow anyone with access to the computer to turn off PPS Monitor. It 
is recommended that you provide a password. 

14. Click OK.Install Card Reader software

Navigate	to	D:\Documents	and	Settings\PPS	User\Desktop\SETUP	FILES\03_CardReaderSoftware	and	double-click	
the	SETUP.EXE	file.	This	installs	Smart	Toolz;	the	required	drivers	for	the	card	reader.

Install the DHCP Sever

1. Navigate	to	C:\Documents	and	Settings\PPS	User\Desktop\SETUP	FILES\05_DHCP

2. Right-click the folder and select Copy.

3. Navigate to the root drive, C:\ 

4. Right-click and select “Paste.”

5. Right-click	 the	 new	 05_DHCP	 folder	
and select “Rename.” 

6. Rename the folder “DHCP”

7. Open the renamed folder.

8. Locate the executable dhcpsvr.exe and 
right-click

9. Select “Run as.”

10. Select “Administrator,” provide the 
administrator password, and click OK 
(see Figure 121).

11. Select “Yes” when asked, “Do you want 
to install it as a service?”

DHCP

File Edit View Favorites Tools Help

Back Search Folders

GoC:\DHCP

dhcpsrv.exe

Run As

Which user account do you want to use to run this program?

Current user 

The Following user:

User name:

Password:

Administrator

OK Cancel

Figure 121. DHCPSRV.EXE Run as administrator.
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